
A-level ICT 

SENIOR Five term 1 

TOPIC 2/2: Electronic Presentation 

Competency: The learner creates and delivers visually appealing and interactive electronic 
presentations to communicate ideas effectively. 

Electronic presentation  

An electronic presentation is a digital display of information, typically using slides created with 

software like PowerPoint or Google Slides that combines text, images, audio, video, and 

animations to communicate ideas visually to an audience, usually projected from a computer 

onto a screen. It's a modern, effective way to present data for business, education, or training, 

enhancing engagement with visual aids and multimedia, and is easily shareable and updatable.  

Components & Features 

(i) Slides: Individual pages holding content (text, images, charts). 

(ii) Multimedia: Integration of audio, video, and graphics. 

(iii) Animations & Transitions: Visual effects for elements on a slide and movement between 

slides. 

(iv) Software: Common tools include Microsoft PowerPoint, Google Slides, Apple 

Keynote, Prezi, and LibreOffice Impress. 

(v) Projector: A device (often an LCD projector) to display the slides for a large audience.  

Advantages 

(i) Visual Appeal: Makes complex information easier to understand. 
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(ii) Engagement: Captures audience attention with multimedia. 

(iii) Flexibility: Easy to edit, share, and store digitally. 

(iv) Efficiency: Reduces paper usage (no need for printed handouts).  

Uses 

(v) Business meetings and training sessions. 

(vi) Classroom instruction. 

(vii) Marketing and sales pitches. 

(viii) Conferences and seminars.  

Tasks: perform the following exercises for your practice 

1. Create three slides of PowerPoint presentations  about your school 
(a) Use  a Master Slide to make all the following settings:  (05 marks) 

(i) All the titles in the presentation should be in one color apart from black. 
(ii) Use the name of the school as Watermark. 
(iii) Insert a thick line 
(iv) Type your name in the footer with font 26 
(v) Type school in the header with font 14 

(b) Slide I 
(i) Type the words Welcome to Our school (Use the school Name) using Word ART (02mark) 
 (ii) Type the school motto below (01mark) 

(c) Slide II  
Type three qualities of your school (03marks) 

(d) Slide III 
Indicate the names of the school director, head teacher and your best teacher (03marks) 

(e) Using the word “education” link slide 2 to slide 3(02marks) 
(f) Insert an updating date on all slides (02mark) 
(g) Insert page number on each slide 
(h) Save and print all the slides on one sheet (02marks) 

2. Use presentation software to design a five-slide presentation on Safe Water Management. 
(a) The slides should include: 

(i) Slide I title and introduction (02marks) 

(ii)  Slide II sources of water (02marks) 

(iii) Slide III Ways of making water safe for drinking (02marks) 

(iv) Slide IV Water-borne diseases (02marks) 

(v) Slide V Conclusion 

(b) Insert appropriate pictures to your slide from Internet. (03marks) 
(c) Set the date to update automatically. (01mark0 
(d) Set a transition of 10 seconds for all slides (02marks) 
(e) Insert your name and slide number as a footer (01marks) 
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(f) Save the presentation as your name and personal numbers. (01mark) 
(g) Print your slides as a handout on one page (02 marks) 

 
3. (a)  Prepare a four –slide presentation about a hotel business as follows: 

(i) Slide One Hotel name in WordArt format, the hotel address and an image (04marks) 
(ii) Slide two Use bullets to outline the services offered (02marks) 
(iii) Slide three Use a table to show the hotel menu for Breakfast and Lunch. (05marks) 
(iv) Slide four Use images or test to represent various drinks and stars or banners to display  

prices of drinks 

(b) Add your name and personal number as a header to all slides. (02 marks) 

(c) Save your work as your name and personal number. (01 mark) 

(d) Print all the sides on one page. (02marks) 

4. In this era of information Technology, youth are vulnerable to many challenges in their life. 
Assuming you are appointed health prefect of your school and you are required to make awareness 
about abstinence: 
(a) Use a suitable presentation software to design a five-slide presentation about abstinence and 

include the following information. 

Slide 1: the topic, your name and current automatic date. (03marks) 

Slide 2: Introduction and definition of abstinence (02marks) 

Slide 3: Advantages of abstinence among the youth (03marks) 

Slide 4:  Youth affected by early sex in 2009- 20%, 2010 – 30%, 2011 – 27%, 2012 -33%. 
Represent the data in tabular form. (03 marks) 

Slide 5: Use a column chart to represent the data in slide four. (03 marks) 

(b) Insert relevant graphics in your presentation. (02 marks) 
(c) Apply suitable animation to your presentation. (01 mark) 
(d) Insert a footer as your name and personal number. (01 mark) 
(e) Save your presentation as your name and personal number (01 mark) 
(f) Print your presentation as a handout on one page. (01 mark) 

5. As a peer educator, you have been told to prepare for workshop where you will address the youth 
about a topic “Adolescence”.  Use appropriate pictures from internet. 
(a) Prepare a presentation with six sides about adolescence as follows: 

Slide one: introduction of the topic (02marks) 
Slide two: characteristics of male adolescence (02marks) 
Slide three: characteristics of female adolescent (02 marks) 
Slide four: effects of uncontrolled adolescence (02marks) 
Slide five: Advice to adolescence (02marks) 
Slide six: Telephone contact is +256-56418545, website address is www.youthclub.org 

and e-mail is info@youthclub.org. 
(b) Insert appropriate picture each to any four slides. (04 marks) 
(c) The presentation should run automatically without stopping. (01 mark) 
(d) Insert your name and automatic date as footer. (02marks) 
(e) Save your presentation as your name and personal number. (01 mark) 
(f) Print all your sides on one page. (01mark) 

 

http://www.youthclub.org/
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6.   E-Commerce is a financial business transaction that occurs over an electronic network such as the  
Internet. 
(a)  You are required to design a four-slide presentation on E-Commerce. Save it as your name and 

personal number. (01mark) 
 Slide I  Introduction of the topic (03 marks) 
 Slide II  Service offered by e-commerce (03marks) 
 Slide III  Advantages of e-commerce and some of this information may included  

(03marks) 
- Shopping can take place any time 
- Customers can exchange goods 
- Variety of commodities to order for 
- A business does not pay for premises. 

Slide IV   Disadvantages of e-commerce. Consider the following: (03 marks) 

 

- Less social interaction between the buyer and the seller 

- It is possible to deal with a fake company and your money may go in wrong 

hands 

- Many people do not trust electronic methods of payment used by e-

commerce. 

(b)  Use suitable animation and transition effects. (02 marks) 

(c) Apply relevant Clip Art on all slides. (02marks) 

(d) Include your name and personal number as header on each slide. (02 marks) 

(e) Save and print your work. (01 marks) 

 

6. Prepare an engaging PowerPoint Electronic presentation for marketing Uganda Coffee as 
follows 

Slide 1: Discover Uganda Coffee 

 Background: image of lush Ugandan coffee plantations. 

 Tagline: “From the Pearl of Africa to Your Cup.” 

 Brief intro: Uganda’s rich volcanic soil and climate produce world-class Arabica and 

Robusta beans. 

Slide 2: Our Origin Story 

 Coffee grown in regions like Mount Elgon and Rwenzori Mountains. 

 Farmers use traditional, sustainable methods. 

 Commitment to fair trade and empowering local communities. 

 Visual: map of Uganda highlighting coffee regions. 

Slide 3: Unique Qualities of Uganda Coffee 

 Rich flavor profile: fruity Arabica, bold Robusta. 

 High altitude cultivation: enhances aroma and taste. 

 Sustainability: eco-friendly farming practices. 

 Freshness guaranteed: beans hand-picked and carefully processed. 
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Slide 4: Coffee for Every Lifestyle 

 Perfect for cafés, offices, and home brewing. 

 Available as whole beans, ground coffee, and ready-to-drink packs. 

 Lifestyle imagery: professionals, students, and families enjoying coffee moments. 

Slide 5: Call to Action 

 Slogan: “Taste Uganda’s Heritage in Every Sip.” 

 Promotions: first-time buyer discounts, subscription service, loyalty rewards. 

 Contact info: website, social media handles, QR code for ordering. 

Task 1 

(i) Create and illustrate slides of the above electronic presentation on marketing 
Uganda coffee in example 1 

(ii) Print your work 

7. Prepare an engaging PowerPoint Electronic presentation for  campaigning for the post of 
head prefect in a secondary school 

Slide 1: Introduction – Meet [Your Name] 

 Photo or illustration of yourself. 
 Title: “Candidate for Head Prefect.” 
 Short tagline: “Leadership through Service and Integrity.” 
 Brief personal introduction (class, interests, passion for leadership). 

Slide 2: Why I Am Running 

 Desire to represent students’ voices. 
 Commitment to discipline, teamwork, and school values. 
 Vision: making the school environment more supportive and inclusive. 
 Quote: “Leadership is about service, not power.” 

Slide 3: My Qualities & Experience 

 Responsible and approachable. 
 Previous leadership roles (class monitor, club leader, sports captain). 
 Strong communication and problem-solving skills. 
 Trusted by peers and teachers. 

Slide 4: My Plans as Head Prefect 

 Strengthen communication between students and administration. 
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 Promote discipline and respect across the school. 
 Organize student activities (debates, sports, cultural events). 
 Encourage mentorship and peer support programs. 

Slide 5: Call to Action 

 Slogan: “Together, We Can Make Our School Better.” 
 Invite classmates to vote and support. 
 Closing line: “Vote [Your Name] for Head Prefect – Leadership You Can Trust.” 
 Visual: school crest or motivational image. 

Task 1 

(i) Create and illustrate slides of the above electronic presentation on campaigning 
for the post of head prefect in example 2 

(ii) Print your work 

 

Popular Electronic Presentation Software 

Software Key Features Best For 

Microsoft 

PowerPoint 

Classic slide-based tool, templates, 

animations, integration with Office 

Business & education 

Google Slides Cloud-based, real-time collaboration, free with 

Google account 

Team projects 

Prezi Non-linear, zooming presentations, dynamic 

storytelling 

Creative storytelling 

Canva Drag-and-drop design, templates, graphics, 

easy sharing 

Visual design-focused 

presentations 

Visme Interactive charts, infographics, multimedia 

integration 

Data-driven presentations 

Beautiful.ai AI-powered slide design, smart templates Quick professional decks 

Apple Keynote Sleek design, smooth animations, Mac/iOS 

integration 

Apple ecosystem users 

Zoho Show Cloud-based, collaboration, integrates with 

Zoho suite 

Business teams 
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Steps to Create a PowerPoint File 

1. Open Microsoft PowerPoint 
o Click the Start Menu (Windows) or Applications (Mac). 
o Select Microsoft PowerPoint. 

2. Choose a Presentation Type 
o Select Blank Presentation to start fresh. 
o Or pick a template/theme for a designed layout. 

3. Add Content to Slides 
o Use the Title Slide for your topic. 
o Click New Slide to add more. 
o Insert text, images, charts, or videos using the Insert tab. 

4. Design Your Presentation 
o Apply themes under the Design tab. 
o Use Transitions and Animations for slide effects. 

5. Save the File 
o Click File → Save As. 
o Choose location (e.g., Desktop, Documents). 
o Enter a file name. 
o Select format: 

 .pptx (default PowerPoint file) 
 .pdf (if you want a non-editable version) 

o Click Save. 

 

Features of Microsoft PowerPoint 

(i) Slide creation: Build structured presentations with text, images, charts, and tables. 
(ii) Templates and themes: Pre-designed layouts and color schemes for professional design. 
(iii) Multimedia integration: Insert videos, audio, graphics, and SmartArt for engaging 

content. 
(iv) Transitions and animations: Add motion effects between slides or to individual elements. 
(v) Collaboration tools: Real-time editing and commenting via OneDrive or SharePoint. 
(vi) Presenter tools: Notes, laser pointer, and slideshow controls for effective delivery. 
(vii) Export and sharing: Save as PPTX, PDF, or video; share via email or cloud. 
(viii) Accessibility features: Screen reader support, alt text, and design suggestions for 

inclusivity. 
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Comparison of Key Features 

Feature Benefit 

Slide creation Organizes ideas visually and logically 

Templates and themes Saves time with professional designs 

Multimedia integration Makes presentations more engaging 

Transitions and animations Adds visual appeal and emphasis 

Collaboration tools Enables teamwork and remote editing 

Presenter tools Supports confident and smooth delivery 

Export and sharing Flexible formats for different audiences 

Accessibility features Ensures inclusivity for all viewers 

Why These Features Matter 

 Education: Teachers use animations and multimedia to make lessons interactive. 
 Business: Professionals rely on templates and charts for clear communication. 
 Collaboration: Students and teams edit slides together in real time. 
 Accessibility: Ensures presentations are usable by diverse audiences. 

Main Commands in PowerPoint 

 File Menu Commands 
o New – create a new presentation. 
o Open – open an existing presentation. 
o Save / Save As – save your work in .pptx or other formats. 
o Print – print slides or handouts. 
o Export – save as PDF, video, or image formats. 

 Home Tab Commands 
o New Slide – add a new slide. 
o Layout – choose slide structure (title, content, etc.). 
o Cut, Copy, Paste – basic editing commands. 
o Font & Paragraph tools – change text style, size, alignment, bullets. 

 Insert Tab Commands 
o Pictures / Online Pictures – add images. 
o Shapes – insert geometric shapes. 
o Charts / Tables – visualize data. 
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o Text Box – add custom text areas. 
o Audio / Video – embed multimedia. 

 Design Tab Commands 
o Themes – apply overall design styles. 
o Variants – adjust colors and fonts. 
o Slide Size – change dimensions (standard/widescreen). 

 Transitions Tab Commands 
o Apply Transition – add effects between slides. 
o Timing – set duration and auto-advance. 

 Animations Tab Commands 
o Add Animation – animate text, images, or objects. 
o Animation Pane – control sequence and timing. 

 Slide Show Tab Commands 
o From Beginning / Current Slide – start presentation. 
o Set Up Slide Show – customize playback options. 
o Presenter View – show notes and controls for the speaker. 

 Review Tab Commands 
o Spelling & Grammar – check text. 
o Comments – add or view feedback. 
o Compare – review changes between versions. 

 View Tab Commands 
o Normal View – default editing mode. 
o Slide Sorter – see all slides at once. 
o Reading View – preview presentation. 
o Zoom – adjust slide magnification. 

� In short: PowerPoint’s main commands cover creating, inserting, designing, animating, 
presenting, reviewing, and viewing slides. 

 

Advice: Create and practice PowerPoint files to get used to PowerPoint Commands 

Thank You 

Dr. Bbosa Science 


